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Course Scheduling Overview 
This guide is organized to introduce the Scientia applications and the Student Information Service Centre 
(SISC) based on their use in the UBC course scheduling process after the draft timetable is released by 
Scheduling Services. Users can read this guide in conjunction with the training content hosted on Canvas. 
Users can self-enroll in the course here: https://canvas.ubc.ca/enroll/CGNHF9. For information on how to 
use Web Data Collector (WDC) to input scheduling requirements at the beginning of the scheduling 
process, please refer to the WDC User Guide.   
 
This document aims to provide users with a step-by-step process while also providing information on why 
the recommended process should be followed and tips for efficiently and effectively using the system.  
 
The course scheduling process involves two systems: 
1) Scientia 

• Scientia is the scheduling system where activity templates are created, planned size is input, and 
resource requirements like, days, times, locations, and instructors, are assigned. 
o Web Data Collector (WDC) 
o Enterprise Course Planner (CP) 
o Enterprise Timetabler (TT) 
o Reference Data Manager (RD) 

 
2) Student Information Service Centre (SISC) 

• SISC receives a transfer of the course section information from Scientia TT and populates the 
course domain for users to complete the required registration data 
o Released seats 
o Permission to Register 
o Publish ‘Yes’ or ‘No’ to the online schedule 
o Section Type, Activity Level, Required Activities, Activity Links 
o Section Publish Notes 
o Mode of Delivery and In-Person Attendance Requirements 

 
It is recommended that users have both Scientia and the SISC launched when doing course scheduling 
after the draft timetable is released to make it more efficient to move between the systems.  
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The workflow below outlines how the systems interact: 

Database Set Up 

Logging into Scientia 
Scientia users are provided with a link to the Scheduling Curriculum Management Centre (SCMC) after 
they have been granted access. Scientia must be launched using Microsoft Edge.  
 
If you are a Mac User, contact Scheduling Services and provide your CWL as you will need to use a VDI to 
access Scientia. We will submit a ticket to Desktop Services to have an EduCloud account created for you. 
 

 
  

Why can’t I access the Scientia applications on the Scheduling and Curriculum Management Centre 
(SCMC)? 
 

Please ensure that you are using Microsoft Edge when launching Scheduling – Courses & Events, for 
course scheduling. 
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The transfer to SISC can take up to 15 minutes
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1) Select the correct database tab 

• The database tab will be named after the corresponding Academic Year (ex. 2019W_2020S) 

• The database you are loading will be highlighted in green: 

 
 

2) Select the application you want to use: 

• Enterprise Course Planner (CP) 

• Reference Data Manager (RD) 

• Enterprise Timetabler (TT) 
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3) Select ‘Reload data from the server.’ as this is the quickest loading option 

• You will need to select ‘Install’ the first time you use Scientia on your computer 

 
 

Academic Year 
• The academic year databases in Scientia are set up per academic year 

o Each academic year’s database is set up August to August and not per term  
o For example; Week 1: August 24th, 2020 and Week 53: August 23rd, 2021 

• Winter and Summer sessions share one database (ex. 2019W and 2020S) 

• There are typically 53 weeks in Scientia per database. In the case that there is a leap year, the 
database will show 65 weeks.  

• Listed below are examples of the corresponding weeks of frequently used Named Availability 
Patterns (NAPs): 
o Winter Term 1: Weeks 3-15 
o Winter Term 2: Weeks 20-25, 27-33 
o Winter Term All: Weeks 3-15, 20-25, 27-33 
o Summer Term 1: Weeks 38-43 
o Summer Term 2: Weeks 46-51 
o Summer Term All: Weeks 38-43, 46-51 

 

Locations & Suitabilities 
• Locations tables will be reviewed and populated at the start of each scheduling cycle, when a new 

database is created.  
o Facilities Planning and Infrastructure Development will manage and update the list and the 

assignment of teaching space in Scientia.  
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Named Availability Patterns (NAP) 
• Pre-defined week patterns to apply to activity templates or to individual activities 

o i.e. Winter Term 1, Winter Term 2, Winter Term 1 Odd Weeks, Winter Term 1 Even Weeks 
o NAPs are created and maintained by Scheduling Services 
o Users select a pattern when creating activity templates to specify the term and weeks the 

activities are to be scheduled for 
 

 
 

Important Icons 

• Writeback  – The Writeback button is how you save your work to commit the changes to the 
database. If you do not click the Writeback icon, your changes will not be committed. 

• Refresh  – The Refresh button is used to view what others have saved in the system while you 
are working.  

 

Column Views & Filtering 

Adding Columns 
To add columns, you will right-click on the header row and select ‘Column Chooser’. To add it to the 
header row, there are two options: 
1) Select the column name and drag it to the header row 
2) Double-click on the column name and it will automatically add to the header row 
 

Removing Columns 
There are two ways to remove columns: 
1) Right-click on the header row, and select ‘Remove This Column’ 
2) Select the column and drag it into the blank area of the screen. An ‘X’ will appear as you drag. When 

you let go, the column will have been removed. 
 

Auto-Filter Row 
An auto-filter row will allow you to type and filter to search quickly. To add an auto-filter row, you will 
right-click on the header row and select ‘Show Auto Filter Row’: 

 

Can new suitabilities be added to the list? 
 

Facilities Planning manages the space inventory on campus. If you need to add new suitabilities, 
please email Learning Spaces via email at learning.spaces@ubc.ca and cc Scheduling Services at 
scheduling.services@students.ubc.ca and they will review your request. 

What if there are no Named Availability Patterns (NAP) that fit what you are trying to schedule? 
 

Users can create a custom pattern to adjust the scheduling weeks to reflect the weeks the activity 
must be scheduled. 
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Enterprise Timetabler (TT) 

Introduction & Set Up 
Users will use Enterprise Timetabler (TT) to complete the following steps in the scheduling process: 

• Reviewing activities allocated GTS by Scheduling Services 

• Adjusting activities in GTS if desired 

• Assigning and editing allocated staff 

• Scheduling and adjusting activities in RTS 
 
The five main areas of Enterprise Timetabler (TT) are:  
1) Icons & Tool Bar 

 

Users will be frequently using the Writeback  and Refresh  icons.  
 
2) Views 

 
 
3) Activities 
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4) Status 

 

5) Refresh 

 

 
 

Activities & Resources 
Users can customize the module screen layout to only show the relevant data columns. 

 

Recommended Column Layout 
The following columns are recommended: 

• Activity Type Name 

• Name 

• Module Name 

• Section ID 

• Planned Size 

• Department Name 

• Duration 

• Scheduled Days 

• Scheduled Start Time 

• Scheduled End Time 

• Scheduled Weeks 

• Allocated Location Name 

You see the Enterprise Timetabler (TT) icon on the taskbar at the bottom of the screen, but why 
won’t it open? 
 

TT is opened in a minimized state. When this occurs, you will see the TT icon on the task bar; however, 
TT does not open on your screen. This can be fixed with the following: 
1) Hover over the TT icon on the taskbar at the bottom of the screen until a grey box appears above 

the icon 
2) Right click on the grey TT box and select Maximize 
3) TT should now open on your screen 

mailto:schedulingservices@students.ubc.ca


Course Scheduling User Guide 
Scheduling Services 

schedulingservices@students.ubc.ca  

 

Last Updated: March 31, 2023  8 
 

• Required Staff Name 

• Allocated Staff Name 

• Tag Names 

• Scheduled 

• Has Problems 

• User Text 3 (WDC Comment Box) 

• Host Key 
 

 
 

Editing Scheduled Course Sections 
When the draft timetable is complete and T-Reps are given access into Scientia, all your course sections 
requiring GTS will be allocated to GTS. You may make changes to these sections yourself, including 
searching for a different location should the one already allocated be unsuitable.   
 
You may also submit a change request to Scheduling Services for assistance in making changes to your 
GTS course sections. For a list of acceptable change requests, please refer to the Academic Course 
Scheduling Operational Procedures. For instructions on how to submit a change request, please see our 
website. 
 
When making changes to sections yourself, you must unschedule the activity first in order to make 
changes. The only exception to this is when adding or changing Staff (i.e. instructors), which can be done 
to a scheduled section. Ensure you do not writeback any changes until you are satisfied with the result.  
 
If you need to make the following changes to a section: 

• Availability (i.e. Term) 

• Duration 

• Planned Size 

• Day/Time 

Terms to Know 
Modules 
Modules in Scientia are brought in from the Faculty Course Management (FCM) for courses and 
courses with detail codes that are available to be scheduled for a specific session. 
 
Modules will appear twice in Scientia, one with a -S and one with a -W extension. The -S or -W identify 
which session the module should be scheduled (Winter or Summer). 
 
Module = course code + course number + course detail code (if applicable) 
 
Activities 
Activities in Scientia most commonly relate to course sections in the SISC. Activities define the type 
of delivery, days, times, term, and location. A section can have multiple activities, so do not always 
assume activity = section. The section ID field in Scientia is the key field for linking activities to the 
same section. If you give multiple activities the same section ID, it will connect the days, times, terms 
for all the activities for the course schedule and registration. 
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Be aware the currently allocated GTS may not be available with the new requirements. You may have to 
look for a new location. 
 
To edit the activities using the Activity Editor, unschedule (right-click on the activity and select 
‘Unschedule’), then double-click on the activity in the Activity window. The following fields can be edited:  

• Availability (i.e. Term) – After applying the change in the Activity Editor, the weeks that the course is 
running will be indicated with green bars 

• Duration – Change the duration by typing in the box or using the arrow keys. The duration is listed in 
half-hour periods, e.g. ‘2’ means a duration of 1 hour, ‘3’ means a duration of 1.5 hours, and so on. 
Duration is the length of time the class meets per meeting. 

 
• Planned Size – The planned size from the activity template can be updated in the Activity Editor on 

Enterprise Timetabler (TT). 

 
 

 
 

What happens if I uncheck the ‘Use Planned Size’ box in the Activity Editor? 
 

By unchecking the ‘Use Planned Size’ box in the Activity Editor, the system will not look at the room 
capacity and will use other requirements defined for the section.  
 
If the planned size is not being used to search for a room, the system may also show available rooms 
that are lower than your intended planned size. Please ensure that the room you are selecting will 
work for the size of the course before scheduling. 
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Resource requirements are found under the ‘Resources’ tab: 

 
Select the ‘+’ icon beside each requirement to edit the respective section: 

• Day/Time – The start time and days of the week the course section meets. 
 

 
 

• Location – Suitabilities work with an “AND” logic so it’s best to select fewer requirements in order 
for the system to show more available options 
o B = Building, F = Feature, RT= Room Type, S = Zone 
o If an on-campus space is required, users must ensure that the required resource is set to ‘1’ or 

greater 
o If there is an off-campus or no physical location required, set the required resource to ‘0’.  

• Staff (i.e. Instructors)  
o If an instructor is required for the section, increase the staff requirement to ‘1’ and the instructor 

can be selected from the ‘Manual selection’. 
o If no instructor is required, such as Exchange, Work Placement, Practicum, Wait List, set the staff 

requirement to ‘0’. 
o Remember, you do not need to unschedule a section before editing the Staff resource  

 

 
 

 

If the course is running multiple days per week, how can I select multiple days? 
 

To select multiple days, hold down the ‘CTRL’ key on the keyboard before selecting the days. 

Can multiple instructors be attached to a course? 
 

Yes, to select multiple instructors, hold down the ‘CTRL’ key on the keyboard before selecting all the 
instructors that are to be attached to the course. 

How do I double-book a staff member? 
  

To allow the double-booking of staff members, please do the following in Enterprise Timetabler (TT):  
1) Go to the Tools (top of page) drop-down menu and select ‘Constraints’ 
2) Once the Constraints box appears, under the ‘Avoid Double Booking Constraint’ category, select 

“Never” for Staff Member and click ‘OK’ at the bottom of the Constraints box to save 
3) Writeback this change. This will allow you to double book staff members. A problem will still be 

triggered and the problem will need to be waived. 
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Finding a New Location 
If the system scheduled you into a room that is not pedagogically suitable, you can go to the ‘Resource’ 
tab and select the ‘Search’ button: 
 

 
***Refresh the system before searching for available rooms to avoid double-booking a location*** 

The Refresh  icon is in the top toolbar. 
 
Selecting the ‘Search’ button will show you a list of other available rooms that meet your resource 
requirements: 
 

 

mailto:schedulingservices@students.ubc.ca


Course Scheduling User Guide 
Scheduling Services 

schedulingservices@students.ubc.ca  

 

Last Updated: March 31, 2023  12 
 

Select a new room, and click ‘Accept’: 

 
 

 
 
After an activity has been scheduled, users will see the following: 
The ‘Scheduled’ column will display a check mark in the Activities window: 

 
If the ‘Has Problems’ column is checked off, right-click the activity and select ‘View Related Problems’ to 
see the details. If you have accidentally double-booked a Location, it will appear here. If the problem is a 
double-booked staff member (instructor) that you did on purpose, you may ignore that problem. 

 

Why doesn’t a room appear when I click the ‘Search’ button even though I know it’s available? 
 

There may be a few reasons: 
1) The planned size in the Activity Editor may exceed the seat capacity of the requested room.  
2) Your term dates and/or start and end time may be incorrect. 
3) The room may be booked on one of your scheduled days. If so, you may need to remove that 

particular week for the activity. 
4) Have you checked the room availability on the Scientia Online Timetable? Make sure you are 

checking the corresponding academic year, as each year will have new link.  
5) The room requirements selected do not match the room requirements in the room 
6) The room may not be included in the selected zone. You will have to remove the zone requirement 

(e.g. S: ENGL) for the room to appear. 
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• The scheduled activity(ies) will appear in the ‘Combined Timetable’ grid for the days and times 
scheduled: 

 

Splitting Course Sections into Multiple Activities 
If you are unable to find a suitable room for your activity, you may wish to split up your location search to 
see if you can find different rooms for each day the course is to run. To split up your location search, 
another activity will need to be generated. 
1) Highlight the activity, right-click and select ‘Generate From Template’ 
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A new line will appear for the newly generated activity. The newly generated activity will inherit all the 
details of the template. 

 
 
2) Edit the activity in the Activity Editor with the same details as the original activity. Make sure that 

the same section ID and availability is given to this second activity.  
3) Define the resource requirements to indicate the other day you are finding a room. Mirror the other 

resource requirements of the first activity. 
 

Creating Arranged Activities (Directed Studies, Practicums, Exchange) 
Some activities may have no formal meeting date and time. Arranged activities are created the same way 
as other activities, with the exception that they are not scheduled. A day, time, and location are not 
required. For these courses, they are to be tagged with ‘Arranged’. It can be tagged with ‘Arranged’ in the 
Activity Editor. 

 
 
Arranged courses do not need to be scheduled. After the course has been tagged with ‘Arranged’, the 
section ID and planned size indicated, select ‘OK’ to apply the changes, and writeback in the system. 
After the course has been saved, it will sync to the SISC. 
 

Creating Jointly Taught Activities 
Jointly Taught activities are also known as cross-listed activities. Activities will be cross-listed when two 
or more activities meet on the same days, times, and location. Jointly taught activities should be created 
in an unscheduled status. All activities that are to be cross-listed should have the same defined Named 
Availability Pattern resource requirements prior to cross-listing.  
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1) In the Activities window, highlight one of the activities that is to be cross-listed 

 
2) Go ‘Actions’ and select ‘Create Jointly Taught Activity’ 

 
 
3) When the ‘Jointly Taught Activities’ window opens up, search for the other module(s) to be cross-

listed: 
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4) Highlight the module that is to be cross-listed and use the arrows in the middle to connect the 
courses: 

 
 
  

mailto:schedulingservices@students.ubc.ca


Course Scheduling User Guide 
Scheduling Services 

schedulingservices@students.ubc.ca  

 

Last Updated: March 31, 2023  17 
 

5) Go to the ‘Options’ tab and ensure that the ‘All’ is selected for the ‘Name’ and ‘Size’. This will 
combine the two activity names and the planned sizes: 

 
 

6) Select ‘OK’ to apply the changes and select the Writeback icon to save the changes in the system. 
 
In the Activities window, the new activity will show a combined name. Review the defined resource 
requirements and then schedule the cross-listed course.  

 
 

 
 

  

Can I delete activities? 
 

Activities can be deleted in Enterprise Timetabler (TT) by highlighting the activity in the Activity 
window, right-clicking, and selecting ‘Delete Activity’. Prior to deleting the activity, ensure that you 
are in the correct database and no students are registered in the activity. If an activity has 
registration and is deleted from Scientia, the section will be cancelled in the SISC and students will be 
immediately dropped from the course.  
 
If all activities associated with one activity template is to be deleted, the activity template can be 
deleted in Course Planner (CP) in the Activity Template Editor.  
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Creating Waitlists 
Waitlist sections will have no location defined in the resource requirements. The day, time, and staff 
requirements will mirror the corresponding activity.  
 
1) Create an activity template and generate an activity for the waitlist on Course Planner (CP): 

 
2) Fill out the planned size, section ID (ex. WL#), and other details to mirror the corresponding activity. 
 
3) Define the resource requirements to mirror the corresponding activity. For the location, indicate 

that it needs no room: 

 
 
4) Schedule the course with no location attached and writeback.  
 

 
 

  

Do I attach the same instructor to the waitlist as the corresponding course? 
 

If the instructor for the corresponding course is confirmed, define this in the resource requirements so 
students have this information. As the corresponding course will also have the instructor attached to 
the course at the same day and time, the double-booking constraint for staff will need to be turned 
off. 
 
Does Scientia automatically register students on the waitlist when a spot opens up in the course? 
 

No, users will need to manually register students from the waitlist when a spot opens up. To ensure 
that students register for the waitlist and do not jump the queue to get into the course, close 
registration once the course is full. 
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How to Print and Export a Timetable from Enterprise Timetabler 
A timetable can be printed and exported from Scientia through Enterprise Timetabler (TT). 

Print 
1) Go to ‘File’ > ‘Print’ > ‘Current Timetable’ 

 
 

2) Once ‘Current Timetable’ is selected, a new window will open with a timetable: 

 

  

mailto:schedulingservices@students.ubc.ca


Course Scheduling User Guide 
Scheduling Services 

schedulingservices@students.ubc.ca  

 

Last Updated: March 31, 2023  20 
 

Export 
3) Go to ‘File’ > ‘Export’ > ‘Activities’, then save the file as an ‘.xls’ file  
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Enterprise Course Planner (CP) 

Introduction & Set Up 
Users will use Enterprise Course Planner (CP) to complete the following steps if needed after the draft 
timetable is released: 

• Creating Activity Templates  

• Generating Activities (ex. sections) 
 
A new course will appear in Course Planner (CP) after it has been approved by Senate or a new detail 
version is created. 
 
Course Planner (CP) opens as a dashboard view. The three main areas for users on the dashboard are as 
follows:  
 
1) Department(s) Filter 

 
• Use the drop-down arrow to the right of the ‘Department(s)’ filter to select your department 
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• Select your department by double-clicking or selecting the arrow to move it over to the ‘Selected’ 
department(s): 

 
 
2) Modules 
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3) Templates 

 

Modules 
The ‘Modules’ section is where you create activity templates. To open the Module Editor, select ‘Show’ 
next to ‘Total’ in the ‘Modules’ section on the dashboard.  

 
 
When the Module Editor opens up, you can create activity templates. 
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Recommended Column Layout 
The following columns are recommended: 

• Name 

• Description 

• Credit Provided 

• Department 

• Total Size 

• Named Availability Pattern 

• Weeks 
 

 
 

 
 

Creating Activity Templates 
1) Search for the module using the auto filter row and typing in the subject in the Name column: 

 
 
2) Select the module session (-S or -W) for the activity template: 

 
 

3) Input the total number of students you expect to have registered across all sections of the module in 
the ‘Total Size’ column: 

 
 

  

How can I see the full details of the module? 
 
Users can see the full details by clicking on the module and selecting ‘Form View’ at the bottom of 
the Module Editor.  
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4) Select ‘Create Activity Template’:  

 

After selecting ‘Create Activity Template’, a row will appear below:  

 
5) Add details to the module by defining the template requirements 

• Name – Add a forward-slash and include the activity type (ex. ‘/LEC’ for lecture, ‘/TUT’ for tutorial, 
etc.). This helps to easily differentiate templates created for the module. 

• Activity Type  

• Duration – Indicate the duration of the module. The duration can also be changed in Enterprise 
Timetabler (TT). 

• Planned Size – Input the total number of students you expect to have registered per section. This 
number must match the total enrolment number on the SISC.  

• Existing Activities – This number refers to the number of activities that have already been created. 

• Zone – Select ‘UBC’ for the UBC Vancouver campus 

• Need To Generate – This number will automatically populate after you input the planned size. The 
system is able to detect the number of activities to generated based off of the planned size and 
module size.  

 
6) Select ‘OK’ to apply the change. If you select ‘Apply’, this will keep the Module Editor open to make 

additional activity templates. 
 

 

When do I need to create a new activity template? 
 

Each type of activity needs its own activity template (e.g. LEC activities must come from a LEC 
template). Therefore, if you need to generate an activity whose type you have not generated before, 
you will need to create a new activity template. If an existing activity template is modified, all sections 
attached to the template will also be modified.  
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Generating Activities 
The ‘Templates’ section is where you generate activities. To open the Activity Template Editor, select 
‘Show’ next to ‘Total’ in the ‘Templates’ section on the dashboard: 

 
 
When the Activity Template Editor opens up, you can generate your activities.  
 

Generating Activities 
1) Search for the module using the auto filter row and typing in the subject in the Name column: 

 
2) Select the activity template you want to generate the activities from 

 
3) The ‘Activities To Generate’ section will auto-populate with the same number from the ‘Need To 

Generate’ column: 
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4) Select the cog wheel icon to generate the activities: 

 

5) Select ‘OK’ to apply the change.  
 

6) Click the Writeback icon on the Course Planner (CP) dashboard to save the changes to the database: 

 

 

 

  

How do you find/confirm the activities you have just generated? There are two options: 
 

1) On the Course Planner (CP) dashboard in the ‘Activities’ section, click on ‘Show’ next to ‘Total’. An 
Activity Editor window will open, and a list of all existing activities will be displayed. Filter to find 
the activities you are looking for.  

2) Find your generated activities for each module in Enterprise Timetabler (TT).  You will need to 
refresh TT after you have applied your changes for the newly generated activities to appear. 
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Reference Data Manager (RD) 

Introduction & Set Up 
Users will use Reference Data Manager (RD) to complete the following steps in the scheduling process: 

• Assigning subject suitabilities to instructors to enable the successful assignment of an instructor to 
an activity on Enterprise Timetabler (TT) 

 

Assigning Suitabilities to Instructors 
1) Go to the ‘Resources’ section and select ‘Show’ next to ‘Staff’: 

 
 
2) A new window will open up. Search for the staff member. 

 
 
3) Go to the ‘Shared With’ column and click into the box 
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4) Search for the department that is to be shared with the instructor and click on the arrow to share it 
with the department: 

 
 
5) Select ‘OK’ to apply the changes and select the Writeback icon to save the changes in the system. 
 

 

  

Why is an instructor not in the Reference Data Manager (RD)? 
 

If an instructor is not viewable in RD, they may not have an active appointment in Workday. As the 
instructor list from RD syncs from Workday, T-Reps will need to follow up with their respective HR 
department. 
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Student Information Service Centre (SISC) 

Introduction & Set Up 
Once a course has been scheduled or tagged with ‘Arranged’ on Enterprise Timetabler (TT), it will sync 
into the Student Information Service Centre (SISC) within 15 minutes. The section details must be 
completed in the SISC before students can register. 
 
Upon logging in: 
1) Go to ‘Preferences’ at the top toolbar and select ‘Tab Settings’: 

 
 
2) Double-click on ‘SISC Sections Controls’ to add it to your saved tabs. Select ‘Save Profile’ and restart 

your SISC and the new tab will appear. 
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3) After the ‘SISC Sections Control’ tab has been added, search for your course: 

 
 
When the search is complete, the screen will update with your course’s information. As the section 
details are not complete, users will see this message: 
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Mandatory Fields 
To complete the section details, users will need to select ‘Edit’ at the bottom of the screen and 
complete the following mandatory fields: 

• Term – The term is to match the start and end date for the course. 

• Activity Level – There are three activity level options; primary, secondary, and tertiary. The activity 
level selected is to match the activity type.  
o Primary – Generally, the main activity (ex. lecture, seminar, etc.) is a primary activity.  
o Secondary – If the main activity has one associated activity, the associated activity will be the 

secondary activity. 
o Tertiary – If the main activity has more than one associated activity, the third associated activity 

will be the tertiary activity. 

• Required Activities – The required activities correspond with the activity levels. 
o Primary Only – If there is only one main activity, this is to be selected. 
o Primary and Secondary – If there is a main activity and one associated activity, this is to be 

selected. 
o Primary, Secondary, and Tertiary – If there is a main activity and two associated activities, this is 

to be selected. 

• Mode of Delivery 

• In-Person Attendance Requirement 
 
After inputting the mandatory fields, review the following fields: 

• Start Date/End Date – Confirm that these dates match the indicated availability on Enterprise 
Timetabler (TT) 

• Section Type 

• Campus Location 

• Publish Section 

• Publish Meeting 

• Publish Rooms 
 
  

Why isn’t my course appearing on SISC? 
 

Please review and ensure all of the below are completed: 
1) The activity has a section ID assigned to it. Section IDs must be 3 characters and any letters are 

capitalized.  
2) Section IDs cannot be changed after the original section ID has been written back to the system. If 

you have modified this after, please change it back and add a new section for the new section ID. 
3) Please make sure all changes have been written back. 
4) It makes approximately 15 minutes from the writeback time for the data to sync from Scientia to 

SISC. 
 

If you have checked all of the above, and they have been completed accordingly but you are still 
experiencing issues, please contact our office for assistance via email at 
schedulingservices@students.ubc.ca 
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After reviewing click ‘Save’. The following prompt will disappear after the section details are complete: 

 
 

Section Type, Campus Location and Associated Student Fees 
Although most course sections will have “REGU” as their section type and “UBC” as the campus location, 

there are some course sections that will not.  Certain combinations of section type and campus location 

will trigger course associated fees when selected.  

 

 
  

Why isn’t my course appearing on the online course schedule? 
 

Please double check the following: 
1) Ensure that you have completed the course section on SISC Section Controls 
2) On the SISC Section Detail tab, please make sure the Publish options were selected: 

a. Publish Section: select Yes 
b. Publish Meeting: select Yes 

3) Was the course added today? An overnight refresh is required before it will display on the 
course schedule. If the course is added after 4pm, it may take 2 overnight refreshes for it to 
appear.  
 

Why can’t students register for my course? 
 

Please double check the following: 
1) You just created a section and will need to wait overnight for the Conflict Checker to run before 

the section is released to students. 
2) The "Permit Students to Register" box under ‘SISC Sections Controls’ on SISC may not be 

checked. 
3) The student may not meet the restrictions. 
4) Section-level restrictions: Restrictions at the section level are located on the UBC Details page, 

under Seat Pool. You may create restrictions that are only applied to the section. When creating 
a restriction, do not type in any of the information for the restrictions, as this will create an 
error. Use the arrows or the drop-down menu. Make sure you save the seat pool and select ‘OK’ 
to go back to the main page. 

5) Senate restrictions: Senate restrictions can be viewed on the Faculty Course Management 
(FCM). Senate restrictions are applied to all of the sections of the course. To remove Senate 
restrictions, contact Senate & Curriculum Services. 

6) Faculty restrictions: Also viewed on the SCMC, these restrictions are applied to all sections of a 
course. Students must meet these restrictions before they are able to register for the course. 

7) Registration may also be prevented based on the student account (e.g., financial holds, advising 
required, not eligible). 
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Attaching Secondary and Tertiary Activities 
To ensure that students are required to register for a secondary or tertiary course section (i.e. 
discussion, lab, tutorial, etc.), the associated courses must be linked to the primary course. By linking the 
courses, students will be prompted to register for the associated course section when they register for 
the primary course section. 
 
The following steps are to be completed after the section details are completed for the primary and 
associated activities: 
1) Search for the primary course in the SISC 

 
2) Click ‘Edit’ and then ‘Maintain Link Sections’: 
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3) Select the associated section(s) to attach and click ‘Add Link’: 

 

 
 
4) Select ‘Accept Changes’ to save: 

 

Mode of Delivery and In-Person Attendance Requirement 

In response to the potential for a wide variety of modes of delivery for courses, a labeling system for the 
UBC Course Schedule has been developed. The priority is to provide a consistent system across all 
Faculties and enable students (and those advising students) the ability to search and distinguish 
between courses that require in-person attendance versus those that are able to be completed 
remotely.  
 
Two label fields “Mode of Delivery” and “Attend in Person” enable students to see the activity type (e.g. 
lecture, laboratory), mode of delivery (e.g. In-person, hybrid, online) and whether in-person attendance 
of a course is required, in most cases without having to go into Section Comments.  
The guide below outlines two key procedures: 

• The decision-making steps required to accurately categorize a course section:  labeling Mode of 
Delivery and whether a course requires in-person attendance 

• Required steps to input the information into the SISC 
 
Important Notes:  

• The implementation and inputting of the SISC fields is required to be completed by the Couse 
Schedule publish date.  Timelines can be found on the website here.  

• The “Mode of Delivery” and “Attend in Person” fields are a requirement and will display for all 
courses. The system has been defaulted to display an “In-Person” mode of delivery and “Yes” 
the course requires in person attendance. All courses that are not changed or updated will 
default to display in this manner. This default setting is intended to lighten the amount of 
manual inputting required by T-Reps, as it is anticipated that most course sections will have an 
in-person component.  
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Categorizing Courses, Labeling Modes of Delivery and whether a Course 

Requires in Person Attendance 
The Course Categorization & Labeling Flow Chart can assist you in determining the categorization for 
your courses and labeling for your course sections. Before utilizing the chart, please ensure to have a full 
understanding of the category definitions and labelling definitions as outlined below. Once you 
understand the category and labelling definitions, follow the flow chart to make the appropriate 
changes in the SISC for each course.  
 

Categorizing Courses 
Each “Course” must fall into one of these three categories:  

• Compulsory in-person: All or some course components require a student to be in-person to 
complete the course. The course can have some online components but certain elements of the 
course require in-person attendance. 

• Non-compulsory in-person: All or some elements of the course are offered in-person, but it is 
also possible to complete the course remotely. 

• Fully online: All course components are done online. No in-person components offered.  
 
For this procedure document the term “Course” describes the combination of a primary activity and 
associated secondary activities. Both the primary and secondary activities as a collective need to be 
considered when deciding which category, a “course” falls into. Please review Labeling for Multi-Section 
Courses. 
 
A “course” (e.g. ANTH 407 001) may consist of one primary activity (e.g. lecture), with a single section 
(001).  

 

In this COMM 101 example below, which consists of multiple activities and sections; they group into two 
“courses”: 

1. COMM 101 Section 101 and associated Tutorials Section T01 – T04  
2. COMM 101 Section 102 and associated Tutorials Section T05 – T08 

 

 

mailto:schedulingservices@students.ubc.ca
https://facultystaff.students.ubc.ca/sites/facultystaff.students.ubc.ca/files/Flow%20Chart%20%28MODE%20and%20ATTD%29.pdf


Course Scheduling User Guide 
Scheduling Services 

schedulingservices@students.ubc.ca  

 

Last Updated: March 31, 2023  37 
 

Mode of Delivery 
Each Activity (Lecture, Seminar, Tutorial, Lab, Discussion etc.) within a Course must be assigned in SISC 
one of four Mode of Delivery labels. This Mode of Delivery label describes how each individual activity 
within a course is going to be delivered to students. 

• In-Person – The course activity is taking place in-person 

• Online – The course activity is fully online and does not require any in-person attendance to 
complete 

• Hybrid – The course activity has a mixture of mandatory in-person and online activities, as 

designed by the instructor 

• Multi-Access - The course activity allows students the choice to attend either in person or online, 

as designed by the instructor 

 

In-Person Attendance Requirement 
Each course must be assigned one of the three labels listed below, which indicates to students whether a 
course requires in-person attendance. This label is critical to a search function that ensures both students 
and those advising students can easily search for and distinguish the courses that can be taken remotely.  

• Yes – The course (combination of the primary and associated secondary activities) does require 
in-person attendance  

• No – The course (combination of the primary and associated secondary activities) does not 
require in-person attendance and therefore can be completed remotely 

• See Section Comments (COMM) – The vast majority of courses will use either “YES” or “NO”. 
However, this label was created to support courses with multiple sections that have shared 
secondary activities. 
 

Examples 
We have provided a number of examples within each of the three categories of Compulsory In-Person, 
Non-Compulsory In-Person and Online. Within each category we have provided a summary of how each 
of the labels apply within that category and a draft view of how the courses will display for students 
within the Course Schedule. 
 
Compulsory in-person: All or some course components require a student to be in-person to complete 
the course. The course can have some online components but certain elements of the course require in- 
person attendance. 

Course Schedule Set up/Display:  

• “Activity” - labeling would remain status quo (lecture, seminar, lab, discussion etc.) 

• “Mode of Delivery” –  all four modes of delivery types can be utilized 

• “Attendance in Person” – at least one of the primary or secondary activity types must be 
labelled YES 

 
Example: MATH 104 lecture and workshop are run in-person. Students are required to attend both the 
lecture and workshops in-person.  
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Example: CHEM 154 lecture is delivered online but students are required to attend in-person for the 
weekly CHEM 154 lab.   

 
 
Example: ENGL 110 lecture is delivered only in-person but discussion groups will be done online.   

 
 
Example: PHYS 117 lecture is delivered in-person and is streamed live for students to attend virtually but 
all Tutorials will be done in-person  

 
 
 
Non-compulsory in-person: All or some elements of the course are offered in-person, but it is also 
possible to complete the course remotely. 

Course Schedule Set up/Display:  

• “Activity” - labeling would remain status quo (lecture, seminar, lab, discussion etc.) 

• “Mode of Delivery” – “online” or “multi-access” must be used 

• “Attendance in Person” - must be labelled NO for all activity types  
 
Example: POLI 100 001 lecture is delivered in-person, and instruction is recorded and made available for 
remote students to access asynchronously at another time. 6 discussion sections, 5 that are delivered in-
person and 1 online. Students attending in-person would select one of the discussions with an in-person 
mode of delivery. Further clarification would be provided in Section Comments (e.g. This course can be 
completed in-person by selecting one of the Discussions L1A-L1E OR to complete this course on-line, select 
Discussion L1F). Through the recorded lecture and the online discussion group a student can complete 
this course remotely.  
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Example: ACAM 300 lecture is delivered in-person and is also recorded for students to attend online, if 
they choose to do so.  

 
 
 
Fully online: All course components are done online. No in-person components offered.  

Course Schedule Set up/Display:  

• “Activity” - labeling would remain status quo (lecture, seminar, lab, discussion etc.)  

• “Mode of Delivery” – only “online” mode of delivery can be utilized 

• “Attendance in Person” - must be labelled NO for all activity types 
 
Example: GEOG 121 is a fully online course. All course components are done online. 

 
 

Labeling for Multi-Section Courses 
Courses with multiple sections of their primary and secondary activities, will result in multiple “course” 
categorizations; and hence allowing for different responses under “Attendance in Person”. 
 
Example: COMM 101 has two different primary lecture sections, each with its own grouping of tutorials. 
Lecture Section 101 and its associated tutorials T01-T04 are being offered in-person. Lecture Section 102 
and its associated tutorials T05-T08 are offered on-line. This distinction allows for students to have COMM 
101 (i.e. COMM 101 Section 102 and associated tutorials T05 – T08) show up for students when searching 
for an online option.  
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Multi-Sections Courses and Shared Secondary Activities 
Courses with multiple sections but shared secondary activities (tutorial, discussions etc.) can have 
different modes of delivery denoted for each section BUT require a different label for “Attendance in 
Person” . It is not possible to simultaneously label the same shared secondary activity as “YES” under one 
lecture section that requires in-person attendance and “NO” under another lecture section that does not 
require in-person attendance. This will cause the search function to produce an error. As a result, for all 
shared secondary activities, the label “Attendance in Person” must be labeled as “SEE SECTION 
COMMENTS”.  
 
Notes to be entered into Section Comments:  

• To attend this course in-person, select the following “primary activity & section code” e.g. 
Lecture 101 

• To attend this course online, select “primary activity & section code” e.g. Lecture 102 
   
Example: BIOL 112 has two different lecture sections but shared tutorials. Lecture Section 101 is being 
offered in-person and has associated online tutorials T01-T03. Lecture Section 102 is being offered online 
and is also associated with online tutorials T01-T03. The tutorials are shared across both lectures. The 
same tutorial cannot be labeled as “YES” for “Attendance in Person” for Lecture Section 101 and 
simultaneously labeled “NO” for Lecture Section 102. Instead it’s labeled as “SEE SECTION COMMENTS”. 
Within the Section Comments, clarification is to be provided (e.g. To attend this course via an in-person 
lecture, select Lecture 101, OR to attend this course on-line, select Lecture 102.) 
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Section Comments 
Section Comments is a place to provide specific details about a Course Section and its specific Activities. 
This should include known details about Mode of Delivery and how students can attend the course. Some 
examples may include, Information about synchronous and asynchronous approaches (such as lecture 
capture), approaches to mid-term exams, etc.   

Required Steps to Input the Information into the SISC  
Important Notes:  

• The following adjustments are done in SISC only.  

• The shared course sections between two departments should display the same Mode of 
Delivery to avoid confusion for students. There should be mutual agreement between both 
departments for which Mode of Delivery is to be used. 

• All adjustments made in SISC after the final timetable has been published will be visible to 
students on the Course Schedule per the regular overnight refresh process.  Timelines can be 
found on our website here. 

In SISC: 

Method 1: Attributes Tab in the SISC 
1) Look up the course section that you need to update 
 
2) Go to SISC Sections Controls > Attribute and click ‘Add’ at the bottom of the page: 
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3) In the pop-up window, under Category, select “MODE” (Mode of Delivery) from the drop-down 

menu: 

 
4) Under Attribute, select the Mode of Delivery that applies to your course section. 
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5) Add in a note/comment for your own reference if you wish. 

 

6) Click ‘Ok’ to save attribute 
 
7) Click ‘Ok’ on the pop-up confirmation screen 
 
8) Click ‘Add’ at the bottom of the page again to add in the 2nd attribute 
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9) Select “ATTD” (Attendance Requirement) from the drop-down menu: 

 

10) Under Attribute, select: 
• ‘YES’ if the Mode of Delivery is In-person or Hybrid and in-person attendance is required  

• ‘NO’ if the Mode of Delivery is Online or Multi Access, and in-person attendance is not required.  

• ‘COMM’ if students must refer to section comments  
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11) Add in a note/comment for your own reference if you wish. 
 
12) Click ‘Ok’ to save attribute 
 
13) Click ‘Ok’ on the pop-up confirmation screen 
 
14) Make sure both attributes appear under Section Attributes before moving on to your next course 

section. 

 

Method 2: Section Detail Tab in the SISC 
In this method, you can directly label the Mode of Delivery and Attendance Requirement in the same 
tab (“Section Detail”) that you used to complete the course section details. 

 

Note: Using this method you will not be able to add an internal note.  To add a note, you will need to do 
so in the “Attributes” tab. 
1) Look up the course section that you need to update 
 
2) Go to SISC Sections Controls > Section Detail tab and click ‘Edit’ at the bottom of the page: 
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3) In the “Mode of Delivery” drop-down menu, select the attribute that applies to your course section: 

  
 
4) Select ATTD (Attendance Requirement) from the drop-down menu: 

• ‘YES’ if in-person attendance is required 

• ‘NO’ if in-person attendance is not required. 

• ‘COMM’ if students must refer to section comments 

 

 

 

 

 

 

 

 

 

 

 
5) Press “Save” at the bottom of the screen once you are done: 

 
 
 
 
 
 

6) Now both attributes appear on the “Section Detail” tab and under Section Attributes in the 
“Attributes” tab.  Verify this before moving on to your next course section. 
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On Section Detail tab: 

 

On “Attributes” tab: 

 

 

Method 3: Bulk Editing Mode of Delivery and Attendance Requirement in the SISC 
In this method, users have the ability to bulk update their course section’s Mode of Delivery and 
Attendance Requirement attribute without having to update each course section individually.   
 
1) Open the Course Search screen in SISC.  This is done by selecting the “Course” tab on the left and 

the “Search Screen” button on the top right corner: 
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2) A new window, which is the Course Search window will open.  Select “Section Mode of Delivery” to 
perform bulk updating actions. 

 
 

3) Enter your search parameters.  Ensure that you have the correct campus and session year entered.  
Press “Search” once you have entered all your details. 
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4) All the courses that match your search parameters will appear on the right-hand side.  Select the 
courses you wish to perform the bulk actions for.  You can select multiple courses by pressing CTRL. 

 
 

5) Once all the courses have been selected, you can update the Mode of Delivery and in-person 
attendance requirement in one of two ways: 
1. Right-click after you have selected the courses you wish to update and go Bulk Actions  

→ MODE/ATTD bulk update 
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2. Go to Bulk Actions at the top menu and select MODE/ATTD bulk update 

 

6) Select the Mode of Delivery and in-person attendance requirement from the drop-down menu.  
Note: The change will apply to all sections selected.   

 

7) Press “Ok” when you have selected the labels. 
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8) A new screen will pop-up to let you know which records are being updated and it will show the new 
mode and attendance requirement.  The bottom right-hand corner will also indicate how many 
records are being updated.  Press “Update” to confirm your changes. 

 

 
9) If the update is successful, you will receive a pop-up that indicates that “MODE/ATTD” insert/update 

successfully.  It will also indicate the number of records (i.e. course sections) that were updated.  
Press “Ok” to close the pop-up. 
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Restricted Teaching Space (RTS) 
The following section walks through the process of confirming and editing course section information in 
Restricted Teaching Space (RTS) for each academic session. Please follow these steps to ensure that 
Scheduling Services can accurately allocate RTS to your respective course sections. This section is only 
applicable to users that have access to RTS.  
 

What is Restricted Teaching Space (RTS)? 
Restricted Teaching Space (RTS) are designated to particular faculties and departments, and only the 
designated faculty or department can book an RTS. RTS are not available for booking by other 
departments and faculties. 
 

Scheduling Restricted Teaching Space (RTS) 
At the start of each academic session, all RTS from the previous year will appear in Web Data Collector.  
 

Web Data Collector (WDC) Input 
When WDC opens for T-Reps to complete the input, T-Reps will review and adjust the course section 
information. Step-by-step instructions can be found in the general WDC User Guide found here. T-Reps 
can do the following in WDC: 

• Make day, time, and staff changes to a course section 

• Add a note that a course section is to be allocated to a specified RTS in the comment box 
 
In the case that an RTS is accidentally removed from the course section, a note can be added to the 
WDC comment box to ask Scheduling Services to re-assign the RTS. 
 

Changes After the Publishing of the Draft Timetable 
T-Reps will be given access into Scientia Timetabler when the draft timetable is made available. At this 
point, T-Reps will be able to make any additional adjustments to their RTS course sections: 

• Attach staff members 

• Move a GTS course section into an RTS 

• Adjust and schedule an RTS course section that could not be scheduled by Scheduling Services 
o If Scheduling Services was unable to allocate a requested RTS to a course section, the T-Rep 

would have been notified and will now have the opportunity to review the course section to 
make an adjustment.  

• Any other adjustments to an RTS course section 
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